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To	get	an	Administrator	Command	Prompt	search	for	cmd.exe	in	the	start	menu,	then	right	click	on	the	command	prompt	entry	and	select	Run	as	administrator.	E-book	files	support	embedding	only	TrueType	and	OpenType	(.ttf	and	.otf)	fonts.	There	are	two	aspects	to	this	problem:	Knowing	the	encoding	of	the	source	file:	calibre	tries	to	guess	what
character	encoding	your	source	files	use,	but	often,	this	is	impossible,	so	you	need	to	tell	it	what	encoding	to	use.	We	also	need	information	about	your	device	that	calibre	will	collect	automatically.	Maybe	Amazon	will	listen.	Metadata	ToCs	will	give	the	people	reading	your	e-books	a	much	superior	navigation	experience	(except	on	the	Kindle,	where
they	are	essentially	the	same	as	a	content	ToC).	Kindly	do	not	contact	us	in	an	attempt	to	get	us	to	change	this.	If	the	crashes	happen	specifically	when	you	are	using	a	file	dialog,	like	clicking	on	the	Add	books	button	or	the	Save	to	Disk	button,	then	you	have	some	software	that	has	installed	broken	Shell	extensions	on	your	computer.	Basically,	stop	a
program,	run	calibre,	check	for	crashes.	Send	both	the	above	outputs	to	us	with	the	other	information	and	we	will	write	a	device	driver	for	your	device.	Note	that	when	converting	HTML	files,	leave	the	input	encoding	setting	mentioned	above	blank.	Get	this	beginner	to	Expert	Kindle	Fire	HD	user	guide	for	your	device.	You	can	copy	or	move	books
between	different	libraries	(once	you	have	more	than	one	library	setup)	by	right	clicking	on	a	book	and	selecting	the	Copy	to	library	action.	To	do	this,	and	if	the	note	below	does	not	apply	to	you,	then:	Set	the	author_sort_copy_method	tweak	to	copy	as	described	above.	Transferring	your	library	in	this	manner	preserver	all	your	metadata,	tags,	custom
columns,	etc.	This	is	because	the	MOBI	format,	alone	amongst	mainstream	e-book	formats,	does	not	have	decent	support	for	a	metadata	ToC.	However,	the	Kindle	firmware	tends	to	malfunction	if	you	disable	the	generation	of	the	end-of-file	inline	ToC.	Also	note	that	if	you	disable	the	generation	of	the	end-of-file	ToC	the	resulting	MOBI	file	may	not
function	correctly	on	a	Kindle,	since	the	Kindle’s	use	the	metadata	ToC	for	many	things,	including	the	Page	Flip	feature.	Press	OK,	at	which	point	calibre	will	change	the	authors	in	all	your	books.	If	you	get	an	error	about	a	missing	DLL	on	Windows,	then	most	likely,	the	permissions	on	your	temporary	folder	are	incorrect.	You	can	force	calibre	to
recalculate	the	author	sort	values	for	all	books	by	using	the	bulk	metadata	edit	dialog	(select	all	books	and	click	edit	metadata,	check	the	Automatically	set	author	sort	checkbox,	then	press	OK).	Widgets	are	either	part	of	the	system	or	derived	from	apps.	This	ToC	is	called	the	content	ToC.	Instruction	How	to	Turn	On/Off	Accessibility	menu	We	can
activate	the	menu	for	user	assistance	or	accessibility	features	on	the	Android	smartphone	by	means	of	an	additional	button	in	right...	You	will	now	have	two	calibre	libraries	on	your	computer	and	you	can	switch	between	them	by	clicking	the	calibre	icon	on	the	toolbar.	Once	you	send	us	the	output	for	a	particular	operating	system,	support	for	the
device	in	that	operating	system	will	appear	in	the	next	release	of	calibre.	You	can	also	create	“virtual	columns”	that	contain	combinations	of	the	metadata	from	other	columns.	Do	this	after	you	have	set	the	author_sort_copy_method	tweak	to	what	you	want.	Connecting	to	it	has	been	known	to	fail	at	random.	When	you	click	Goto	Table	of	Contents	on
your	Kindle,	it	is	to	this	extra	content	ToC	that	the	Kindle	takes	you.	Something	on	your	computer	is	preventing	calibre	from	accessing	its	own	temporary	files.	If	you	are	connecting	an	Apple	iDevice	(iPad,	iPod	Touch,	iPhone),	Apple	no	longer	allows	third	party	software	to	connect	to	their	devices	using	a	USB	cable.	One	is	the	traditional	Table	of
Contents,	like	the	ToC	you	find	in	paper	books.	Some	devices,	like	the	Kindle	(1/2/DX),	do	not	allow	you	to	access	port	8080	(the	default	port	on	which	the	content	server	runs).	In	addition,	although	the	calibre	command	line	utilities	do	not	need	a	running	X	server,	some	of	them	do	require	the	X	server	libraries	to	be	installed	on	your	system.	This	file	is
where	calibre	stores	the	metadata	like	title/author/rating/tags	etc.	The	tones	and	vibration	during...	Consider	using	the	calibre	Content	server	to	make	your	books	available	on	other	computers.	Additionally,	calibre	is	a	single	user	application,	if	you	accidentally	run	two	copies	of	calibre	on	the	same	networked	library,	bad	things	will	happen.	This
prevents	calibre	from	opening	them.	Or	if	you	accidentally	moved	the	folder.	You	can	obtain	many	such	fonts	on	the	web.	If	re-downloading	it	does	not	work,	download	it	from	an	alternate	location.	The	Content	server	allows	you	to	read	books	directly	in	Safari	itself.	How	it	is	represented	is	up	to	the	viewer	program.	In	other	words,	do	not	run	the	file
syncing	tool	and	calibre	at	the	same	time.	If	the	file	resides	on	a	device,	you	may	have	reached	the	limit	of	a	maximum	of	256	files	in	the	root	of	the	device.	That	is,	uninstall	calibre,	delete	C:\Program	Files\Calibre2	(or	wherever	you	previously	chose	to	install	calibre).	How	to	manage	your	content	and	security	more	efficiently.	They	try	to	download	a
cover	for	the	book	from	their	servers	and	when	that	fails,	they	replace	the	existing	cover	that	calibre	created	with	a	generic	cover.	There	are	two	ways	that	you	can	connect	your	Android	device	to	calibre.	Remember	that	while	you	may	think	your	feature	request	is	extremely	important/essential,	calibre	developers	might	not	agree.	Suppose	your	book
collection	is	nicely	sorted	into	folders	with	the	following	scheme:	Genre	->	Author	->	Series	->	ReadStatus	Now	this	makes	it	very	easy	to	find	for	example	all	science	fiction	books	by	Isaac	Asimov	in	the	Foundation	series.	MOBI	files	often	have	.azw	or	.azw3	file	extensions.	Columns	can	be	added	via	Preferences → Interface → Add	your	own	columns.	.
If	you	are	still	not	convinced,	then	I’m	afraid	calibre	is	not	for	you.	Now	it	might	well	seem	to	you	that	the	MOBI	book	has	two	identical	ToCs.	Remember	that	one	is	semantically	a	content	ToC	and	the	other	is	a	metadata	ToC,	even	though	both	might	have	exactly	the	same	entries	and	look	the	same.	calibre	is	a	very	popular	program	and	unscrupulous
people	try	to	setup	websites	offering	it	for	download	to	fool	the	unwary.	Here	you’ll	learn:	Why	use	Kindle	Fire	HD.	Download	Book	Stay	Updated	Got	a	new	Kindle	FIRE	HD	8	or	10?	Instruction	Make	a	call	Calling	someone	is	simple,	it	can	be	challenging	if	you	never	had	an	Android	device	before.		Instruction	How	to	Turn	On/Off	Instant	Lock	with
Power	button	If	you	activate	this	option,	pressing	your	power	button	will	not	only	set	your	device	into	sleep	mode,	but	will	also	lock	your	device	regardless...	However,	that	workaround	is	only	possible	when	using	a	USB	connection	and	sending	with	calibre.	Because	of	the	large	amount	of	spam	in	email,	sending	email	can	be	tricky,	as	different	mail
servers	use	different	strategies	to	block	email.	You	will	now	have	an	empty	calibre,	with	just	the	Getting	Started	guide	in	your	library.	Copy	it	to	a	file	and	repeat	the	process,	this	time	with	your	device	disconnected	from	your	computer.	Given	that	calibre’s	mission	is	to	get	you	to	stop	storing	metadata	in	filenames	and	stop	using	the	filesystem	to	find
things,	the	increased	robustness	afforded	by	the	id	numbers	is	well	worth	the	uglier	folder	names.	Restart	calibre.	Simply	copy	this	folder	to	your	new	computer	and	follow	the	instructions	below	to	import	the	data.	If	that	doesn’t	solve	it,	look	for	a	corrupted	font	file	on	your	system,	in	~/Library/Fonts	or	the	like.	Instruction	How	to	Add	App	shortcut
on	Home	screen	If	we	use	the	app	drawer	on	the	Android	smartphone,	all	apps	are	stored	in	one	place.		For	apps	that	are	used	more	often,	shortcuts	can	be...	This	is	the	folder	you	chose	for	your	calibre	library	when	you	ran	calibre	for	the	first	time.	Watch	the	tutorial	UI	Power	tips	to	learn	how	to	create	your	own	columns,	or	read	this	blog	post.
Similarly,	if	the	installer	is	failing/rolling	back	and	you	have	Microsoft	PowerToys	running,	quit	it.	For	a	list	of	the	various	issues	you	will	encounter	when	converting	PDF,	see:	Convert	PDF	documents.	When	adding	HTML	files	to	calibre,	you	may	need	to	tell	calibre	what	encoding	the	files	are	in.	You	will	see	a	list	of	books	in	Safari,	tap	on	any	book
and	you	will	be	given	the	option	to	either	download	it,	or	read	it	in	the	browser	itself.	To	learn	how	to	do	this	see	Adding	your	favorite	news	website.	This	is	because	of	Qt,	which	is	used	for	various	image	processing	tasks,	and	links	against	these	libraries.	Note:	on	Windows,	the	device	must	have	a	drive	letter	for	calibre	to	use	it.	You	can	also	tell
calibre	to	automatically	start	the	Content	server	via	Preferences → Sharing → Sharing	over	the	net.	Once	again,	right	click	the	calibre	button	and	choose	Export/import	all	calibre	data.	You	are	using	a	Wacom	branded	USB	mouse/tablet.	Remember	that	this	is	different	from	the	Author	sort	field	for	a	book.	The	features	of	Kindle	Fire	HD.	Note	calibre
needs	GLIBC	>=	2.18	and	libstdc++	>=	6.0.21.	Finally,	you	can	add	downloaded	news	to	the	calibre	library	with:	/opt/calibre/calibredb	add	--with-library	/path/to/library	outfile.epub	Remember	to	read	the	Command	Line	Interface	section	of	the	calibre	User	Manual	to	learn	more	about	these,	and	other	commands.	Note	that	the	contents	of	this	folder
are	automatically	managed	by	calibre,	do	not	add	any	files/folders	manually	to	this	folder,	as	they	may	be	automatically	deleted.	Otherwise,	you	can	request	a	particular	news	site	by	posting	in	the	calibre	Recipes	forum.	Finally,	I	encourage	you	to	ditch	the	content	ToC	and	only	have	a	metadata	ToC	in	your	e-books.	Note	Amazon	have	removed	the
ability	to	manipulate	collections	completely	in	their	newer	models,	like	the	Kindle	Touch	and	Kindle	Fire,	making	even	the	above	plugin	useless,	unless	you	root	your	Kindle	and	install	custom	firmware.	In	order	to	convert	a	collection	of	HTML	files	in	a	specific	order,	you	have	to	create	a	table	of	contents	file.	On	macOS	if	you	get	permission	errors
when	connecting	a	device	to	calibre,	you	can	fix	that	by	looking	under	System	Preferences	>	Security	and	Privacy	>	Privacy	>	Files	and	Folders.	The	Kobo	has	very	buggy	firmware.	This	is	useful	when	dealing	with	names	that	calibre	will	not	get	right,	such	as	complex	multi-part	names	like	Miguel	de	Cervantes	Saavedra	or	when	dealing	with	Asian
names	like	Sun	Tzu.	Do	this	by	going	to	Preferences → Advanced → Plugins → File	type	and	customizing	the	HTML	to	ZIP	plugin.	If	you	are	getting	an	error	when	connecting	to	your	touch	with	calibre	try	the	following,	each	of	which	has	solved	the	problem	for	some	calibre	users.	calibre	is	a	completely	open	source	product.	This	is	most	likely	the	culprit
if	the	upgrade	process	is	hanging	in	the	middle.	First	let’s	see	how	to	export	the	data:	Right	click	the	calibre	icon	in	the	main	calibre	toolbar	and	select	Export/import	all	calibre	data.	calibre	has	a	builtin	web	server,	the	The	calibre	Content	server.	First,	you	must	install	calibre	onto	your	Linux	server.	Whenever	you	add	a	book	to	calibre,	it	will	copy
the	book	into	that	folder.	Change	all	author	names	to	LN,	FN	using	the	Manage	authors	dialog.	If	you	are	using	a	file-syncing	tool	it	is	essential	that	you	make	sure	that	both	calibre	and	the	file	syncing	tool	do	not	try	to	access	the	calibre	library	at	the	same	time.	Turn	it	off	and	you	should	be	fine.	(On	some	operating	systems,	you	may	not	be	able	to
run	the	server	on	a	port	number	less	than	1024	because	of	security	settings.	Remember	to	use	“Restart	Explorer”	or	reboot	your	computer	after	disabling	the	shell	extensions.	How	to	get	endless	entertainment	with	your	Kindle	Fire.	In	other	words,	the	Kindle	only	displays	covers	for	books	marked	as	Personal	Documents	or	books	bought	directly	from
Amazon.	The	source	code	is	available	for	download.	At	the	command	prompt	type	the	following	command	and	press	Enter:	Post	any	output	you	see	in	a	help	message	on	the	Forum.	But	do	not	start	calibre	from	the	installation	wizard.	You	will	see	a	list	of	all	your	calibre	libraries.	Make	sure	it	says	some	thing	like	“Transferring	Media	files”	or	“MTP
(Media	Transfer	mode)”.	In	such	apps	you	can	go	to	the	online	catalog	screen	and	add	the	IP	address	of	the	calibre	server	to	browse	and	download	books	from	your	calibre	library	within	the	app.	Goto	Preferences → Sharing → Sharing	books	by	email	in	calibre	and	click	the	Use	GMX	button	and	fill	in	the	information	asked	for.	You	can	switch	calibre	to
using	a	backed	up	library	folder	by	simply	clicking	the	calibre	icon	on	the	toolbar	and	choosing	your	backup	library	folder.	For	example,	one	common	request	is	to	have	calibre	display	author	names	LN,	FN.	Being	Indian,	that’s	the	natural	spelling	for	me.	First	reboot	your	computer	in	safe	mode,	to	have	as	few	running	programs	as	possible,	and	see	if
the	crashes	still	happen.	If	you	see	a	file	named	metadata.db,	delete	it.	To	remedy	this,	do	a	right-click	on	the	calibre	icon	in	the	calibre	toolbar	and	select	Switch/create	library.	The	first	step	to	using	an	Android	device	is	installing	an	e-book	reading	application	on	it.	A...	calibre	will	automatically	rebuild	metadata.db.	Certain	combinations	of
motherboard,	USB	ports/cables/hubs	can	exacerbate	this	tendency	to	fail.	If	it	does	not,	tap	the	notification,	and	change	the	mode	to	Media	Transfer	(MTP).	If	the	calibre	installer	you	downloaded	is	not	opening,	try	downloading	it	again.	So	if	you	want	to	put	calibre	on	a	CD	with	your	product,	you	must	also	put	the	calibre	source	code	on	the	CD.	You
can	now	browse	your	book	collection	and	download	books	from	calibre	to	your	device	to	open	with	whatever	e-book	reading	software	you	have	on	your	Android	device.	Then	click	the	button	labelled	Import	previously	exported	data.	One	can	be	accessed	directly	from	the	Kindle’s	menus,	the	other	cannot.	Note	that	doing	this	will	mean	that	the
generated	MOBI	will	show	up	under	personal	documents	instead	of	Books	on	the	Kindle	Fire	and	Amazon	whispersync	will	not	work,	but	the	covers	will.	If	you	must	share	the	actual	library,	use	a	file	syncing	tool	like	DropBox	or	rsync	instead	of	a	networked	drive.	Others,	however,	can	be	resized.	Instruction	How	to	Resize	a	Widget	Many	widgets
have	a	predefined	size	on	Android	that	cannot	be	changed.	You	can	still	use	calibre	to	store	and	transfer	them	to	your	e-book	reader.	This	is	likely	deliberate	on	Amazon’s	part	to	try	to	force	authors	to	sell	only	through	them.	Just	copy	the	contents	of	the	backup	folder	into	the	current	configuration	folder	to	restore.	See	The	calibre	Content	server	for
details	on	running	the	server	and	finding	out	the	right	IP	address	to	use.	See	Development.	At	the	most	basic	level,	a	calibre	library	is	just	a	folder.	At	the	command	prompt	type	the	following	command	and	press	Enter:	icacls	"%appdata%\..\Local\Temp"	/reset	/T	Alternately,	you	can	run	calibre	as	Administrator,	but	doing	so	will	cause	some
functionality,	such	as	drag	and	drop	to	not	work.	Note	that	if	you	send	using	email,	Amazon	will	automatically	mark	the	MOBI	file	as	a	Personal	Document	and	the	cover	will	work,	but	the	book	will	show	up	in	Personal	Documents.	The	whole	point	of	calibre’s	library	management	features	is	that	they	provide	a	search	and	sort	based	interface	for
locating	books	that	is	much	more	efficient	than	any	possible	folder	scheme	you	could	come	up	with	for	your	collection.	Select	the	folder	with	the	exported	data	that	you	copied	over	earlier.	As	of	version	4.17,	calibre	has	a	workaround,	where	if	you	connect	the	Kindle	to	calibre	after	the	covers	have	been	destroyed	by	Amazon,	calibre	will	restore	them
automatically.	You	can	find	the	device	node	of	your	device,	which	will	always	be	under	/dev	by	examining	the	output	of:	Neither	the	Kindle	nor	the	Nook	provide	any	way	to	manipulate	collections	over	a	USB	connection.	MOBI	books	can	be	of	two	types	Mobi6	and	KF8.	Run	calibre	on	a	single	computer	and	access	it	via	the	Content	server	or	a	Remote
Desktop	solution.	The	list	of	books	that	calibre	displays	is	created	by	reading	the	contents	of	this	metadata.db	file.	If	your	file	is	open	in	another	program.	In	the	MOBI	format,	the	situation	is	a	little	confused.	It	is	also	part	of	what	allows	calibre	to	magically	regenerate	the	database	with	all	metadata	if	the	database	file	gets	corrupted.	This	can	be	done
in	the	GUI	via	the	Input	character	encoding	field	in	the	Look	&	feel → Text	section	of	the	conversion	dialog.	Many	reading	apps	support	browsing	the	calibre	library	directly	via	its	OPDS	support.	I	encourage	you	to	contact	Amazon	customer	support	and	complain	loudly	about	this	bug.	In	that	case,	change	the	port	in	the	calibre	Preferences	to	80.	In
the	add	column	dialog	use	the	Quick	create	links	to	easily	create	columns	to	show	the	book	ISBN	or	formats.	Alternately,	simply	keep	your	Kindle	in	airplane	mode,	you	don’t	really	want	Amazon	knowing	every	book	you	read	anyway.	Try	turning	off	VoiceOver	if	you	have	it	on.	Once	this	is	done,	EPUB	books	transferred	with	calibre	will	work	fine	on
your	reader.	calibre	fully	supports	both.	However,	it	is	still	possible	to	assign	names	to	a	folder	or	to	rename...	If	you	are	reasonably	proficient	with	computers,	you	can	teach	calibre	to	download	news	from	any	website	of	your	choosing.	This	means	that	if	file	A.html	links	to	B.html	and	C.html	and	D.html,	but	B.html	also	links	to	D.html,	then	the	files
will	be	in	the	order	A.html,	B.html,	D.html,	C.html.	Right	click	the	calibre	icon	in	the	calibre	toolbar	and	select	Library	maintenance->Restore	database.	When	recalculating	the	author	sort	values	for	books,	calibre	uses	the	author	sort	values	for	each	individual	author.	Read	the	error	message	carefully,	see	what	file	it	points	to	and	fix	the	permissions
on	that	file	or	its	containing	folders.	As	such,	it	is	unlikely	that	any	calibre	developers	will	ever	feel	motivated	enough	to	support	it.	Fortunately,	calibre	is	open	source,	which	means	you	always	have	the	option	of	implementing	your	feature	yourself,	or	hiring	someone	to	do	it	for	you.	See	how	to	report	bugs.	Also	note	that	Amazon	does	not	allow	email
delivery	of	AZW3	and	new	style	(KF8)	MOBI	files.	The	library	folder	and	all	its	contents	make	up	what	is	called	a	calibre	library.	If	you	send	a	MOBI	file	to	an	e-ink	Kindle	with	calibre	using	a	USB	connection,	calibre	works	around	this	Amazon	bug	by	uploading	a	cover	thumbnail	itself.	Where	and	how	to	get	apps	to	increase	your	Kindle	Fire’s
efficiency.	That	number	is	the	id	number	of	the	book	record	in	the	calibre	database.	Ensure	your	operating	system	is	seeing	the	device.	PDB	is	also	a	generic	format.	First,	unlock	the	screen	before	plugging	in	the	USB	cable.	By	default,	calibre	uses	whatever	proxy	settings	are	set	in	your	OS.	Then	there	is	the	metadata	ToC.	Whenever	you	add	a	book
to	calibre,	that	book’s	files	are	copied	into	this	folder	(arranged	into	sub	folders	by	author	and	title).	One	common	cause	of	failures	on	macOS	is	the	use	of	accessibility	technologies	that	are	incompatible	with	the	graphics	toolkit	calibre	uses.	A	MOBI	book	simulates	the	presence	of	a	metadata	ToC	by	putting	an	extra	content	ToC	at	the	end	of	the
book.	If	you	have	a	hand	edited	ToC	in	the	input	document,	you	can	use	the	ToC	detection	options	in	calibre	to	automatically	generate	the	metadata	ToC	from	it.	The	bug	in	Amazon’s	software	is	that	when	you	put	a	MOBI	file	on	a	Kindle,	unless	the	file	is	marked	as	a	Personal	document,	Amazon	assumes	you	bought	the	book	from	it	and	tries	to
download	the	cover	thumbnail	for	it	from	its	servers.	Make	sure	you	are	clicking	the	download	links	on	the	left,	not	the	advertisements	on	the	right.	You	can	clear	the	cache	by	following	these	instructions.	Most	network	filesystems	lack	various	filesystem	features	that	calibre	uses.	You	can	run	the	calibre	server	via	the	command:	/opt/calibre/calibre-
server	/path/to/the/library/you/want/to/share	You	can	download	news	and	convert	it	into	an	e-book	with	the	command:	/opt/calibre/ebook-convert	"Title	of	news	source.recipe"	outputfile.epub	If	you	want	to	generate	MOBI,	use	outputfile.mobi	instead	and	use	--output-profile	kindle.	Then,	calibre	will	automatically	put	that	file	into	the	correct	folder	and
move	it	around	when	the	title/author	changes.	Open	a	bug	requesting	the	feature.	In	addition,	using	the	Connect	to	folder	function	you	can	use	it	with	any	e-book	reader	that	exports	itself	as	a	USB	disk.	Make	sure	that	your	user	account	has	full	control	for	this	folder.	If	you	are	sending	to	your	Kindle,	remember	to	update	the	email	preferences	on
your	Amazon	Kindle	page	to	allow	email	sent	from	your	GMX	email	address.	This	means	that	you	are	free	to	redistribute	calibre	as	long	as	you	make	the	source	code	available.	If	you	create	an	AZW3	file	with	a	metadata	ToC	and	no	end-of-file	generated	ToC,	some	features	on	the	Kindle	will	not	work,	such	as	the	Page	Flip	feature.	If	the	crash	happens
when	you	are	trying	to	copy	text	from	the	calibre	E-book	viewer,	it	is	most	likely	caused	by	some	clipboard	monitoring/managing	application	you	have	running.	The	first	thing	to	check	is	that	you	are	downloading	calibre	from	the	official	website.	Known	culprits	include:	SpiderOak,	odrive	sync	and	Dell	Backup	and	Recovery	and	NetDrive.	It	will	run
the	Welcome	wizard	asking	you	for	the	location	of	the	calibre	library.	Input	Formats:	AZW,	AZW3,	AZW4,	CBZ,	CBR,	CB7,	CBC,	CHM,	DJVU,	DOCX,	EPUB,	FB2,	FBZ,	HTML,	HTMLZ,	LIT,	LRF,	MOBI,	ODT,	PDF,	PRC,	PDB,	PML,	RB,	RTF,	SNB,	TCR,	TXT,	TXTZ	Output	Formats:	AZW3,	EPUB,	DOCX,	FB2,	HTMLZ,	OEB,	LIT,	LRF,	MOBI,	PDB,	PMLZ,
RB,	PDF,	RTF,	SNB,	TCR,	TXT,	TXTZ,	ZIP	Note	PRC	is	a	generic	format,	calibre	supports	PRC	files	with	TextRead	and	MOBIBook	headers.	In	this	case,	you	can	ask	calibre	to	rebuild	the	metadata.db	from	its	backups.	There	can	be	two	reasons	why	calibre	is	showing	a	empty	list	of	books:	Your	calibre	library	folder	changed	its	location.	If	the	files	have
their	owner	set	to	a	user	other	than	you.	See	The	calibre	Content	server	for	details.	Look	elsewhere	for	your	book	cataloguing	needs.	A	permission	denied	error	can	occur	because	of	many	possible	reasons,	none	of	them	having	anything	to	do	with	calibre.	There	are	several	possible	things	I	know	of,	that	can	cause	this:	You	recently	connected	an
external	monitor	or	TV	to	your	computer.	Temporarily	disable	your	antivirus	program	(disconnect	from	the	Internet	before	doing	so,	to	be	safe)	Look	inside	the	folder	you	chose	for	your	calibre	library.	The	only	way	to	find	the	culprit	is	to	eliminate	the	programs	one	by	one	and	see	which	one	is	causing	the	issue.	Once	you	press	OK,	there	is	no	undo.
You’ll	learn	all	the	above	and	even	more	about	your	new	Kindle	Fire	HD	device	from	this	user	guide.	Note	that	on	macOS	and	Linux	only	a	single	program	can	connect	to	an	Android	device	at	a	time,	so	make	sure	the	device	is	not	opened	in	the	OS	File	manager,	or	the	Android	File	Transfer	utility,	etc.	Most	purchased	EPUB	books	have	DRM.	Need	a
guide	to	help	you	up	and	running	on	your	device?	It	can	convert	every	input	format	in	the	following	list,	to	every	output	format.	Try	a	clean	install.	For	such	devices,	you	can	simply	add	/mobile	to	the	server	URL	to	get	a	simplified,	non-JavaScript	interface.	To	do	this	go	to	Preferences → Advanced → Plugins → File	type	and	customize	the	HTML	to	ZIP
plugin,	telling	it	what	encoding	your	HTML	files	are	in.	This	will	create	some	debug	output.	In	this	case	the	simplest	solution	is	to	adjust	your	router	to	forward	requests	on	port	80	to	port	8080).	Now	when	you	add	HTML	files	to	calibre	they	will	be	correctly	processed.	You	can	also	tell	calibre	whether	to	put	it	at	the	start	or	the	end	of	the	book	via	an
option	in	the	MOBI	Output	settings.	If	the	debug	output	contains	a	line	that	looks	like:	Qt:	internal:	-108:	Error	ATSUMeasureTextImage	text/qfontengine_mac.mm	then	the	problem	is	probably	a	corrupted	font	cache.	I	encourage	you	to	contact	Amazon	and	ask	them	to	fix	this	bug.	Only	Kobo	seems	to	understand	that	life	is	too	short	to	be	entering
collections	one	by	one	on	an	e-ink	screen	�	Note	that	in	the	case	of	the	Kindle,	there	is	a	way	to	manipulate	collections	via	USB,	but	it	requires	that	the	Kindle	be	rebooted	every	time	it	is	disconnected	from	the	computer,	for	the	changes	to	the	collections	to	be	recognized.	For	example	if	you	are	using	Microsoft	Edge,	try	using	Firefox	or	Chrome
instead.	If	you	choose	to	download	it,	Safari	will	ask	you	if	you	want	to	open	it	with	iBooks.	Connect	the	Kobo	directly	to	your	computer,	not	via	USB	Hub	Try	a	different	USB	cable	and	a	different	USB	port	on	your	computer	Log	out	of	the	Kobo	and	log	in	again,	this	causes	it	to	rebuild	the	database,	fixing	corrupted	database	errors.	For	details	see	this
forum	thread.	By	managing	books	in	its	own	folder	structure	of	Author	->	Title	->	Book	files,	calibre	is	able	to	achieve	a	high	level	of	reliability	and	standardization.	If	you	don’t	know	the	new	location	search	your	computer	for	the	file	metadata.db.	Unfortunately,	Amazon	has	not	provided	any	way	to	deduce	which	book	is	causing	a	crash	on	the	Kindle.
Then	re-install	calibre.	Finally,	some	users	have	reported	that	disabling	UAC	fixes	the	problem.	This	can	take	some	time.	Inside	the	calibre	library	folder,	at	the	top	level,	you	will	see	a	file	called	metadata.db.	Also	go	to	System	Preferences->System->Universal	Access	and	turn	off	the	setting	for	enabling	access	for	assistive	devices	in	all	the	tabs.
When	you	plugin	in	the	USB	cable	you	will	get	a	popup	notification.	Finally,	Amazon	recently	started	sending	confirmation	emails	that	you	have	to	click	on	back	to	your	GMX	account	before	the	book	is	actually	delivered.	If	you	want	to	backup	the	calibre	configuration/plugins,	you	have	to	backup	the	config	folder.	If	you’re	wondering,	calibre	is	the
British/commonwealth	spelling	for	caliber.	If	you	are	using	the	64-bit	version	of	calibre	try	switching	to	the	32-bit	version.	Filter	Alarm	clock	Apps	&	Shortcuts	Battery	Browser	Contacts	Data	warning	and	limit	Date	&	Time	Developer	Options	Display	Display	enhancements	Do	not	disturb	Fingerprint	Folder	Functions	Groups	Home	screen	Interaction
and	dexterity	Languages	&	Input	Location	Lock	screen	Memory	card	Messages	(SMS)	Mobile	data	Mobile	network	Network	Phone	Privacy	Screen	lock	Screen	reader	Screen	saver	Security	&	Privacy	Shutter	Smart	Lock	Status	bar	Storage	System	sounds	Tethering	Timer	Vibrations	Volume	Volume	&	Tones	Wi-Fi	Direct	Widgets	Popularity	Latest
content	Manuals	Where	can	I	find	the	user	manual	for	the	Amazon	Fire	HD	8	Plus?	Instruction	How	to	Add	Widget	to	the	Home	screen	Widgets	are	small	useful	tools	with	which	the	home	screen	can	be	personalized.	for	every	book	in	your	calibre	library.	So	it	is	recommended	that	you	leave	the	generated	ToC	alone.	calibre	is	designed	to	have	columns
for	the	most	frequently	and	widely	used	fields.	For	details,	see	The	GNU	GPL	v3.	If	the	book	still	does	not	show	up	after	some	time,	then	it	is	likely	that	the	Kindle	indexer	crashed.	You	can	control	whether	the	Tag	browser	display	authors	using	their	names	or	their	sort	values	by	setting	the	categories_use_field_for_author_name	tweak	in	Preferences 
→ Advanced → Tweaks	Note	that	you	can	set	an	individual	author’s	sort	value	to	whatever	you	want	using	Manage	authors.	Note	Microsoft/GMX	can	disable	your	account	if	you	use	it	to	send	large	amounts	of	email.	This	file	is	a	sqlite	database.	Instruction	Gradually	increase	alarm	volume	If	you	have	problems	with	waking	up	in	the	morning,	you	could
activate	this	option	to	let	the	alarm	sound	ring	louder	gradually.	To	illustrate	why	a	search/tagging	based	interface	is	superior	to	folders,	consider	the	following.	It’s	your	choice	which	functionality	is	more	important	to	you.	There	can	be	several	causes	for	this:	If	you	get	an	error	about	calibre	not	being	able	to	open	a	file	because	it	is	in	use	by	another
program,	do	the	following:	Uninstall	calibre	Reboot	your	computer	Re-install	calibre.	First	perform	the	following	steps	in	calibre:	Set	the	Preferred	Output	Format	in	calibre	to	EPUB	for	normal	Android	devices	or	MOBI	for	Kindles	(The	output	format	can	be	set	under	Preferences → Interface → Behavior)	Convert	the	books	you	want	to	read	on	your
device	to	EPUB/MOBI	format	by	selecting	them	and	clicking	the	Convert	button.	You	can	still	press	Cancel	to	abandon	the	changes.	Note	that	if	you	are	using	the	user	defined	plugin	for	a	device	normally	detected	by	a	builtin	calibre	plugin,	you	must	disable	the	builtin	plugin	first,	so	that	your	user	defined	plugin	is	used	instead.	In	that	case,	right-
click	the	calibre	icon	in	the	toolbar	and	point	it	to	the	newly	copied	folder.	In	calibre	go	to	Preferences → Miscellaneous	and	click	the	“Debug	device	detection”	button.	Sometimes	these	are	incorrect,	for	example,	on	Windows	if	you	don’t	use	Microsoft	Edge	then	the	proxy	settings	may	not	be	up	to	date.	Another	cause	can	be	some	third	party	apps	that
modify	system	behavior,	such	as	Smart	Scroll.	Download	the	operating	instructions	for	the	Amazon	Fire	HD	8	Plus	in	various	languages	as	a	PDF	document.	Now	re-install	and	you	should	be	fine.	Just	so	we’re	clear,	this	is	not	going	to	change.	Try	temporarily	disabling	your	antivirus	program	(Microsoft	Security	Essentials,	or	Kaspersky	or	Norton	or
McAfee	or	whatever).	Note	This	import/export	functionality	is	only	available	from	calibre	version	2.47	onwards.	Instruction	How	to	Turn	On/Off	Charging	sounds	and	vibration	When	the	charging	cable	is	plugged	in	under	Android,	a	sound	and	a	short	vibration	are	heard	for	a	short	feedback.	Instruction	How	to	Connect	via	Wi-Fi	Direct	Wi-Fi	Direct
can	be	seen	as	some	kind	of	"different	Wi-Fi".	In	order	to	understand	why	that	happened,	you	have	to	understand	what	a	calibre	library	is.	Turn	on	the	Content	server	by	clicking	the	Connect/share	button	and	leave	calibre	running.	Open	the	Manage	authors	dialog.	Indeed,	once	you	become	comfortable	using	calibre’s	interface	to	find,	sort	and	browse
your	collection,	you	won’t	ever	feel	the	need	to	hunt	through	the	files	on	your	disk	to	find	a	book	again.	Simply	plug	your	device	into	the	computer	with	a	USB	cable.	You	can	use	the	option	in	the	Table	of	Contents	section	in	the	conversion	dialog	to	control	how	the	Table	of	Contents	is	generated.	Many	servers	(for	example,	Amazon)	block	email	that
does	not	come	from	a	well	known	relay.	In	calibre,	go	to	Preferences → Ignored	Devices	and	check	that	your	device	is	not	being	ignored	If	all	the	above	steps	fail,	go	to	Preferences → Miscellaneous	and	click	Debug	device	detection	with	your	device	attached	and	post	the	output	as	a	ticket	on	the	calibre	bug	tracker.	A	portable	version	of	calibre	is
available	here.	To	change	the	size	of	a	widget,	it	must...	The	exported	data	will	be	saved	in	this	folder.	In	this	case,	calibre	cannot	find	its	library	and	so	starts	up	with	an	empty	library	instead.	It	is	available	from	here.	HTML	files	from	different	sources	often	have	different	encodings,	so	you	may	have	to	change	this	setting	repeatedly.	If	the	antivirus
program	is	preventing	you	from	downloading/installing	calibre,	disable	it	temporarily,	install	calibre	and	then	re-enable	it.	A	filesystem	is	a	complex	beast.	This	can	happen	if	it	was	on	an	external	disk	and	the	drive	letter	for	that	disk	changed.	If	you	don’t	mind	risking	your	account	being	blocked	you	can	reduce	this	wait	interval	by	going	to
Preferences → Advanced → Tweaks	in	calibre.	You	can	create	new	libraries,	remove/rename	existing	ones	and	switch	between	libraries	easily.	Antivirus	programs	use	heuristics,	patterns	of	code	that	“look	suspicious”	to	detect	viruses.	The	first	thing	to	realize	is	that	most	e-books	have	two	tables	of	contents.	This	is	caused	by	a	bug	in	the	Amazon
software.	See	this	thread	for	details.	For	example,	in	the	calibre	E-book	viewer,	you	use	the	Show	Table	of	Contents	button	to	see	this	ToC.	You	can	manage	individual	authors	by	right	clicking	on	the	author	in	the	Tag	browser	on	the	left	of	the	main	calibre	window	and	selecting	Manage	authors.	A	metadata	ToC	is	a	ToC	that	is	not	part	of	the	book	text
and	is	typically	accessed	by	some	special	button	on	a	reader.	Follow	the	instructions	in	the	answer	above	for	adding	custom	columns.	You	can	get	permission	denied	errors	if	you	are	using	an	SD	card	with	write	protect	enabled.	You	can	also	use	the	NirSoft	Shell	Extension	Viewer	to	see	what	shell	extensions	are	installed	on	your	system	and	disable
them	individually,	if	you	don’t	want	to	uninstall	the	full	program.	Try	upgrading	the	firmware	on	your	Kobo	Touch	to	the	latest	Try	resetting	the	Kobo	(sometimes	this	cures	the	problem	for	a	little	while,	but	then	it	re-appears,	in	which	case	you	have	to	reset	again	and	again)	Try	only	putting	one	or	two	books	onto	the	Kobo	at	a	time	and	do	not	keep
large	collections	on	the	Kobo	This	happens	because	of	an	Amazon	bug.	First,	you	must	authorize	your	reader	on	a	Windows	machine	with	Adobe	Digital	Editions.	Go	to	the	folder	file:C:\Users\USERNAME\AppData\Local	in	Windows	Explorer	and	then	right	click	on	the	file:Temp	folder,	select	Properties	and	go	to	the	Security	tab.	You	can	use	the
powerful	calibre	template	language	to	do	much	more	with	columns.	When	the	download	fails,	it	refuses	to	fallback	to	the	cover	defined	in	the	MOBI	file.	Press	the	copy	all	author	sort	values	to	author	button.	There’s	no	easy	way	to	do	this	with	this	folder	scheme,	you	would	instead	need	a	folder	scheme	that	looks	like:	ReadStatus	->	Genre	->	Author	-
>	Series	In	calibre,	you	would	instead	use	tags	to	mark	genre	and	read	status	and	then	just	use	a	simple	search	query	like	tag:scifi	and	not	tag:read.	Note	that	calibre	only	supports	HTTP	proxies	not	SOCKS	proxies.	If	your	server	is	using	a	modern	Linux	distribution,	you	should	have	no	problems	installing	calibre	onto	it.	Log	into	your	GMX	account	on
the	website	and	enable	SMTP	sending	(Settings->POP3	&	IMAP->Send	and	receive	emails	via	external	program)	calibre	will	then	be	able	to	use	GMX	to	send	the	mail.	The	e-book	file	will	be	stored	in	the	folder	“My	Digital	Editions”,	from	where	you	can	add	it	to	calibre.	If	the	computer	you	are	transferring	to	already	has	a	calibre	installation,	then	the
Welcome	wizard	won’t	run.	Author	names	are	complex,	especially	across	cultures,	see	this	note	for	some	of	the	complexities.	We	just	need	some	information	from	you:	Complete	list	of	e-book	formats	that	your	device	supports.	Simply	download	the	.ttf/.otf	files	and	add	them	to	the	Library/Fonts	folder	in	your	home	folder.	Instruction	How	to	Create	a
Folder	on	Home	screen	Apps	can	be	sorted	into	folders	on	the	home	screen.	This	can	take	a	while.	You	can	either	choose	a	preinstalled	sound	or	one	of	your	own	songs.	These	are	typically	generated	by	OCR	software.	This	is	because	the	HTML	to	ZIP	plugin	automatically	converts	the	HTML	files	to	a	standard	encoding	(UTF-8).	The	presence	of	the
number	allows	you	to	have	multiple	records	with	the	same	title	and	author	names.	If	this	network	is	not	available,	you	can	deactivate	the	option	and...	This	will	most	likely	take	care	of	the	problem.	Now	on	your	Android	device,	open	the	browser	and	browse	to	Replace	192.168.1.2	with	the	local	IP	address	of	the	computer	running	calibre.	Note	If	you
are	concerned	about	giving	calibre	access	to	your	email	account,	simply	create	a	new	free	email	account	with	GMX	or	Outlook	and	use	it	only	for	calibre.	You	can	find	out	what	the	library	folder	is	by	clicking	the	calibre	icon	in	the	toolbar.	To	send	us	the	output,	open	a	bug	report	and	attach	the	output	to	it.	Shopping	with	your	Kindle	Fire.	For	more
details,	see	The	calibre	template	language.	If	none	of	the	above	apply	to	you,	then	there	is	some	other	program	on	your	computer	that	is	interfering	with	calibre.	Finally,	you	might	get	a	popup	on	the	device	every	time	calibre	or	the	operating	system	actually	tries	to	connect	to	it,	asking	for	permission,	tap	OK.	There	is	an	incompatibility	between
Wacom	drivers	and	the	graphics	toolkit	calibre	uses.	Choose	the	Switch/create	calibre	library	action	and	you	will	see	the	path	to	the	current	calibre	library.	Go	through	the	list	one	by	one,	and	select	the	new	location	for	each	library	(a	location	is	just	an	empty	folder	somewhere	on	your	computer).	Furthermore,	calibre	has	a	comprehensive	plugin
architecture,	so	you	might	be	able	to	develop	your	feature	as	a	plugin,	see	Writing	your	own	plugins	to	extend	calibre’s	functionality.	calibre	has	a	very	flexible	strategy	for	managing	author	names.	In	this	case,	whenever	calibre	opens	a	new	window	like	the	edit	metadata	window	or	the	conversion	dialog,	it	appears	on	the	second	monitor	where	you
don’t	notice	it	and	so	you	think	calibre	has	frozen.	Note	When	changing	from	FN	LN	to	LN,	FN,	it	is	often	the	case	that	the	values	in	author_sort	are	already	in	LN,	FN	format.	Kindle	books	are	DRM	protected	and	therefore,	unlike	ebooks	that	are	in	PDF	or	ePUB	format,	you	cannot	read	this	ebook	without	the	official	Kindle	apps.	Sometimes	a
particular	book	can	cause	the	indexer	to	crash.	A	book	can	have	more	than	one	author,	and	an	author	can	have	more	than	one	book.	at	the	same	time.	It’s	rather	like	racial	profiling.	This	Table	of	Contents	is	part	of	the	main	document	flow	and	can	be	styled	however	you	like.	In	addition,	you	can	add	any	columns	you	like.	You	can	get	the	path	to	the
library	folder	by	clicking	the	calibre	icon	on	the	main	toolbar.	Disconnect	your	second	monitor	and	restart	calibre.	How	to	get	maximum	battery	efficiency.	The	most	common	problem	is	if	you	are	sending	email	directly	(without	a	mail	relay)	in	calibre.	In	this	case	you	need	to	reformat	the	device/sd	card	referred	to	in	the	error	message	with	a	FAT32
filesystem,	or	delete	some	files	from	the	SD	card/device	memory.	The	user	guide	will	take	you	from	zero	to	expert	level	Kindle	user	in	minimal	time.	If	you	really	care	about	using	collections,	I	would	urge	you	to	sell	your	Kindle/Nook	and	get	a	Kobo.	Now	coming	to	author	name	sorting:	When	a	new	author	is	added	to	calibre	(this	happens	whenever	a
book	by	a	new	author	is	added),	calibre	automatically	computes	a	sort	string	for	both	the	book	and	the	author.	If	you	still	cannot	get	the	installer	to	work	and	you	are	on	Windows,	you	can	use	the	calibre	portable	install,	which	does	not	need	an	installer	(it	is	just	a	ZIP	file).	Instruction	How	to	Remove	App	shortcut	from	Home	screen	The	added	app
shortcuts	can	be	removed	from	the	home	screen	of	the	Android	smartphone	at	any	time	if	the	quick	access	is	no	longer	needed....	If	you	have	the	official	download	and	your	antivirus	program	is	still	claiming	calibre	is	a	virus,	then,	your	antivirus	program	is	wrong.	You	can	repair	the	filesystem	with:	sudo	fsck.vfat	-y	/dev/sdc	Replace	/dev/sdc	with	the
path	to	the	device	node	of	your	device.	The	following	programs	have	been	reported	to	cause	crashes	in	calibre:	If	you	are	running	any	of	these,	close	them	before	starting	calibre,	or	uninstall	them:	RoboForm,	Logitech	SetPoint	Settings,	Constant	Guard	Protection	by	Xfinity,	Spybot,	Killer	Network	Manager,	Nahimic	UI	Interface,	Acronis	True	Image.
Go	to	the	folder	C:\Users\USERNAME\AppData\Local	in	Windows	Explorer	and	then	right	click	on	the	Temp	folder	and	select	Properties	and	go	to	the	Security	tab.	Books	in	the	folder	are	nicely	arranged	into	sub-folders	by	Author	and	Title.	See	the	conversion	section	of	the	User	Manual	for	more	details	on	how	to	use	these	options.	If	you,	or	some
program	you	used	changed	the	file	permissions	of	the	files	in	question	to	read	only.	DOCX	files	from	Microsoft	Word	2007	and	newer	are	supported.	You	can	work	around	it	by	going	to	Preferences → Conversion → Output	Options → MOBI	output	and	setting	the	Enable	sharing	of	book	content	option.	Note	With	the	Kindle	Fire	8	or	newer	there	is	an	icon
that	shows	up	when	the	USB	cable	is	plugged	in,	showing	that	the	device	is	charging.	The	latest	version	can	always	be	downloaded	from	the	calibre	website.	Remember	this	ToC	is	semantically	a	metadata	ToC,	in	any	format	other	than	MOBI	it	cannot	not	be	part	of	the	text.	Some	don’t	support	file	locking,	some	don’t	support	hardlinking,	some	are
just	flaky.	Therefore,	ensure	that	the	individual	author	sort	values	are	correct	before	recalculating	the	books’	author	sort	values.	Please	report	the	false	identification	to	whatever	company	you	buy	your	antivirus	software	from.	Your	metadata.db	file	was	deleted/corrupted.	You	can	email	downloaded	news	with	the	command:	/opt/calibre/calibre-smtp	I
leave	figuring	out	the	exact	command	line	as	an	exercise	for	the	reader.	The	most	likely	such	culprit	is	a	program	that	modifies	other	programs’	behavior,	such	as	an	antivirus,	a	device	driver,	something	like	RoboForm	(an	automatic	form	filling	app)	or	an	assistive	technology	like	Voice	Control	or	a	Screen	Reader.	Note	The	newer	AZW3	format	has
proper	support	for	a	metadata	ToC.	Using	a	USB	cable	–	or	wirelessly,	over	the	air.	If	you	are	connecting	a	Kindle	Fire	or	other	Android	device,	read	the	note	under	Using	a	USB	cable.	You	will	need	to	fix	the	underlying	cause	of	the	permissions	error	before	resuming	to	use	calibre.	So	in	order	to	see	the	covers	on	your	Kindle,	you	have	to:	Send	the
book	to	the	Kindle	with	calibre	Disconnect	the	Kindle	and	wait	for	Amazon	to	destroy	the	cover	Reconnect	the	Kindle	to	calibre	Note	that	this	workaround	only	works	for	books	sent	with	calibre	4.17	or	later.	It	connects	compatible	devices	with	each	other	even	if	they	have	no	Wi-Fi	connection...	In	addition	to	the	Connect	to	folder	function	found	under
the	Connect/share	button,	calibre	provides	a	User	defined	device	plugin	that	can	be	used	to	connect	to	any	USB	device	that	shows	up	as	a	disk	drive	in	your	operating	system.	You	can	have	multiple	such	libraries.	If	you	get	an	error	about	a	Python	function	terminating	unexpectedly	after	upgrading	calibre,	first	uninstall	calibre,	then	delete	the	folders
(if	they	exists)	C:\Program	Files\Calibre	and	C:\Program	Files\Calibre2.	The	command-line	tools	have	an	ebook-convert-txt-input	--input-encoding	option.	Note	With	newer	Android	devices,	you	might	have	to	jump	through	a	few	hoops	to	get	the	connection	working,	as	Google	really	does	not	want	you	to	be	independent	of	its	cloud.	Try	downloading	the
installer	with	an	alternate	browser.	But	suppose	you	want	to	find	all	unread	science	fiction	books.	Some	users	have	reported	that	running	the	following	command	in	an	Administrator	Command	Prompt	fixed	their	permissions.	When	you	purchase	an	epub	book	from	a	website,	you	will	get	an	“.acsm”	file.	You	cannot	use	either	code	or	libraries	from
calibre	in	your	software	without	making	your	software	open	source.	Most	fonts	on	macOS	systems	are	in	.dfont	format,	thus	they	cannot	be	embedded.	In	addition,	there	are	many	apps	for	your	iDevice	that	can	connect	to	the	calibre	Content	server.	If	your	device	appears	as	a	USB	disk	to	the	operating	system,	adding	support	for	it	to	calibre	is	very
easy.	This	ToC	cannot	be	styled	by	the	book	creator.	Start	the	Safari	browser	and	type	in	the	IP	address	and	port	of	the	computer	running	the	calibre	server,	like	this:	Replace	192.168.1.2	with	the	local	IP	address	of	the	computer	running	calibre.	The	creation	of	a	folder	under	Android	is	done	by	merging	at	least	two	apps	or	app	icons.	Do	not	change
any	book	metadata	before	doing	the	remaining	steps.	If	you	want	to	add	a	file	associated	to	a	particular	book,	use	the	top	right	area	of	Edit	metadata	dialog	to	do	so.	After	the	import	completes,	calibre	will	restart,	with	all	your	old	libraries,	settings	and	calibre	plugins.	If	they	still	happen,	stop	another	program	and	repeat.	It’s	going	to	be	the	best
money	you’re	going	to	invest!	What	are	you	waiting	for?!	You	can	become	an	expert	with	your	Kindle	Fire	HD	Tablet!	Scroll	up	and	Download	your	copy	today!	This	is	the	Kindle	version	of	Kindle	Fire	HD	8	&	10	Manual:	All	New	Fire	HD	User	Guide	(Kindle	Fire	Guide,	Beginner	to	Expert	Guidebook,	Complete	with	Instructions)	that	you	can	also
download	and	read	on	your	computer	and	mobile	phone.	Finally,	different	OSes	impose	different	limitations	on	filesystems,	so	if	you	share	your	networked	drive	across	OSes,	once	again,	bad	things	will	happen.	The	fact	that	it	is	part	of	the	text	in	MOBI	is	an	accident	caused	by	the	limitations	of	MOBI.	Note	If	the	workaround	is	not	working	for	you
make	sure	you	Kindle	firmware	is	at	least	version	5.12.5,	released	in	April	2020.	If	you	get	an	ImportError	about	some	Qt	modules,	you	are	likely	missing	some	X	libraries.	Try	rebooting	your	computer	and	running	a	registry	cleaner	like	Wise	registry	cleaner.	When	converting	to	MOBI,	calibre	detects	the	metadata	ToC	in	the	input	document	and
generates	an	end-of-file	ToC	in	the	output	MOBI	file.	Once	you	have	found	the	problem	book,	delete	it	off	the	Kindle	and	do	a	MOBI	to	MOBI	or	MOBI	to	AZW3	conversion	in	calibre	and	then	send	it	back.	Downloading	from	the	Internet	can	sometimes	result	in	a	corrupted	download.	Then	connect	your	device	to	the	computer.	See	the	device	plugin
Preferences	->	Plugins	->	Device	plugins	->	User	defined	and	Preferences	->	Miscellaneous	->	Get	information	to	setup	the	user	defined	device	for	more	information.	If	you	get	an	error	in	the	Welcome	wizard	on	an	initial	run	of	calibre,	try	choosing	a	folder	like	C:\library	as	the	calibre	library	(calibre	sometimes	has	trouble	with	library	locations	if	the
path	contains	non-English	characters,	or	only	numbers,	etc.)	Try	running	it	as	administrator	(Right	click	on	the	icon	and	select	Run	as	administrator)	If	it	still	won’t	launch,	start	a	command	prompt	(press	the	Windows	key	and	R;	then	type	cmd.exe	in	the	Run	dialog	that	appears).	This	user	guide	is	written	EXCLUSIVELY	for	all	new	Fire	HD	devices.
You	can	change	this	algorithm	by	going	to	Preferences → Advanced → Tweaks	and	setting	the	author_sort_copy_method	tweak.	Do	not	put	your	calibre	library	on	a	networked	drive.	Click	the	little	blue	icon	to	select	the	new	location	of	your	calibre	library	and	click	OK.	Do	not	have	another	calibre	supported	device	like	an	iPhone/iPad	etc.	You	must
backup	this	complete	folder	with	all	its	files	and	sub-folders.	If	they	do	not,	then	you	know	it	is	some	program	causing	the	problem.	In	order	of	decreasing	preference:	LIT,	MOBI,	AZW,	EPUB,	AZW3,	FB2,	FBZ,	DOCX,	HTML,	PRC,	ODT,	RTF,	PDB,	TXT,	PDF	PDF	is	a	terrible	format	to	convert	from.	Tap	that	and	switch	the	device	to	data	transfer	mode,
and	then	start	calibre,	it	should	then	be	detected.	Check	through	the	authors	to	be	sure	you	are	happy.	First	perform	the	following	steps	in	calibre	Set	the	Preferred	Output	Format	in	calibre	to	EPUB	(The	output	format	can	be	set	under	Preferences → Interface → Behavior)	Set	the	output	profile	to	iPad	(this	will	work	for	iPhone/iPods	as	well),	under
Preferences → Conversion → Common	options → Page	setup	Convert	the	books	you	want	to	read	on	your	iDevice	to	EPUB	format	by	selecting	them	and	clicking	the	Convert	button.	Yes,	you	can.	Instead	use	a	wireless	connection,	via	the	calibre	Content	server.	After	you	have	changed	all	the	authors,	press	the	Recalculate	all	author	sort	values	button.	If
instead	you	want	the	order	to	be	A.html,	B.html,	C.html,	D.html	then	you	must	tell	calibre	to	add	your	files	in	breadth	first	order.	Try	adding	an	exclusion	for	calibre	in	your	antivirus	program.	calibre	supports	the	conversion	of	many	input	formats	to	many	output	formats.	You’ll	be	able	to	use	the	features	of	your	Fire	HD	device	like	a	seasoned	pro
after	you’ve	followed	the	book	through.	Note	that	restoring	configuration	folders	is	not	officially	supported,	but	should	work	in	most	cases.	You	can	obtain	debug	output	about	why	calibre	is	not	starting	by	running	Console.app.	Examples	include:	Marvin,	Mapleread	and	iBooks	itself.	The	most	robust	way	to	setup	email	sending	in	calibre	is	to	do	the



following:	Create	a	free	GMX	account	at	GMX.	If	there	is	a	filesystem	error	on	the	device	which	caused	your	operating	system	to	mount	the	filesystem	in	read	only	mode	or	mark	a	particular	file	as	read	only	pending	recovery.	If	you	want	a	ToC	at	a	particular	location	in	your	document	text,	create	one	by	hand.	Start	calibre	From	now	on	you	should	be
able	to	start	calibre	normally.	Simply	copy	the	calibre	library	folder	from	the	old	to	the	new	computer.	With	all	this	flexibility,	it	is	possible	to	have	calibre	manage	your	author	names	however	you	like.	Click	OK.	First,	if	your	device	supports	SD	cards,	insert	them.	Instruction	How	to	Rename	a	Folder	Under	Android,	names	are	no	longer	displayed
under	newly	created	folders.	You	can	turn	this	off	by	an	option	in	the	MOBI	Output	settings.	This	means,	that	if	you	want	to	send	a	calibre	produced	EPUB	to	an	online	store	that	uses	an	EPUB	validity	checker,	you	have	to	make	sure	that	the	EPUB	is	valid	yourself,	calibre	will	not	do	it	for	you	–	in	other	words	you	must	feed	calibre	valid	XHTML	+	CSS
as	the	input	documents.	Getting	familiar	with	your	Fire	HD.	You	have	two	choices:	Create	a	patch	by	hacking	on	calibre	and	send	it	to	me	for	review	and	inclusion.	The	most	important	thing	to	backup	is	the	calibre	library	folder,	that	contains	all	your	books	and	metadata.	Note	Google	recently	deliberately	broke	their	email	sending	protocol	(SMTP)
support	in	an	attempt	to	force	everyone	to	use	their	web	interface	so	they	can	show	you	more	ads.	When	a	book	has	multiple	authors,	separate	their	names	using	the	&	character.	Finally,	the	reason	there	are	numbers	at	the	end	of	every	title	folder,	is	for	robustness.	They	are	trying	to	claim	that	SMTP	is	insecure,	that	is	incorrect	and	simply	an
excuse.	Most	likely	the	permissions	on	your	Temp	folder	are	incorrect.	There	are	many	free	and	paid	e-book	reading	applications	for	Android:	Some	examples	(in	no	particular	order):	FBReader,	Moon+,	Mantano,	Aldiko,	Kindle.	Make	sure	that	your	user	account	has	full	control	for	this	folder.	Instruction	How	to	Turn	On	Automatic	Network	selection
Usually	the	Android	9	device	connects	to	your	phone	company	automatically.	calibre	embeds	fonts	in	e-book	files	it	creates.	The	guide	is	packed	with	detailed	instructions	and	numerous	important	tips.	You	may	need	to	restart	calibre	at	this	point	in	order	for	your	device	to	be	recognized.	Even	after	doing	this,	you	may	have	problems.	calibre	should
automatically	detect	the	device	and	then	you	can	transfer	books	to	it	by	clicking	the	Send	to	device	button.	You	can	tell	calibre	to	use	a	particular	proxy	server	by	setting	the	http_proxy	and	https_proxy	environment	variables.	calibre	has	a	Content	server	that	exports	the	books	in	calibre	as	a	web	page.	You	can	browse	it	on	your	device	using	a	simple
browser	or	a	dedicated	application.	The	only	guarantee	it	makes	is	that	if	you	feed	it	valid	XHTML	1.1	+	CSS	2.1	it	will	output	a	valid	EPUB.	Is	there	a	special	folder	on	the	device	in	which	all	e-book	files	should	be	placed?	You	can	manage	the	authors	of	a	book	by	the	edit	metadata	dialog.	Books	sent	to	the	Kindle	only	show	up	on	the	Kindle	after	they
have	been	indexed	by	the	Kindle.	Also	some	devices	do	not	have	browsers	advanced	enough	to	run	the	app-like	interface	used	by	the	Content	server.	Turn	on	the	Content	server	in	calibre’s	preferences	and	leave	calibre	running.	calibre	supports	eReader,	Plucker	(input	only),	PML	and	zTxt	PDB	files.	calibre	shows	only	TrueType	and	OpenType	fonts
found	on	your	system.	Debug	output	will	be	printed	to	it.	To	manage	the	libraries,	click	the	calibre	icon	on	the	toolbar.	This	file	should	be	opened	with	Adobe	Digital	Editions,	which	will	then	download	the	actual	“.epub”	e-book.	Linux	kernels	mount	devices	read-only	when	their	filesystems	have	errors.	If	you	have	an	older	version	of	calibre,	or	if	you
encounter	problems	with	the	import/export,	you	can	just	copy	over	your	calibre	library	folder	manually,	as	described	in	the	next	paragraph.	If	you	have	an	older	server,	you	will	either	need	to	compile	these	from	source,	or	use	calibre	3.48	which	requires	GLIBC	>=	2.17	or	2.85.1	which	requires	GLIBC	>=	2.13	or	calibre	1.48	which	requires	only
GLIBC	>=	2.10.	Then	click	the	button	labelled	Export	all	your	calibre	data.	A	backed	up	library	folder	backs	up	your	custom	columns	and	saved	searches	as	well	as	all	your	books	and	metadata.	You	can	see	the	current	proxies	used	by	calibre	in	Preferences->Miscellaneous.	Finally,	you	can	connect	wirelessly	to	any	device	that	has	a	web	browser
using	the	calibre	Content	server.	Click	OK	and	choose	an	empty	folder	somewhere	on	your	computer.	If	you	need	a	tool	that	always	produces	valid	EPUBs,	calibre	is	not	for	you.	If	the	installer	still	doesn’t	work,	then	something	on	your	computer	is	preventing	it	from	running.	Install	calibre	on	your	new	computer	and	run	through	the	Welcome	wizard,
it	does	not	matter	what	you	do	there,	as	you	will	be	importing	your	old	settings	in	the	next	step.	So	we	strongly	recommend	that	you	leave	the	default	as	it	is,	i.e.	with	the	metadata	ToC	at	the	end	of	the	book.	It	makes	your	calibre	collection	available	over	the	net.	Try	using	a	non-Wacom	mouse.	Also	does	the	device	detect	files	placed	in	sub-folders?
Take	your	pick:	Converter	And	LIBRary	for	E-books	A	high	calibre	product	A	tribute	to	the	SONY	Librie	which	was	the	first	e-ink	based	e-book	reader	My	wife	chose	it	;-)	calibre	is	pronounced	as	cal-i-ber	not	ca-li-bre.	Metadata	about	the	books	is	stored	in	the	file	metadata.db	at	the	top	level	of	the	library	folder.	You	can	force	calibre	to	recalculate	the
author	sort	values	for	every	author	by	right	clicking	on	any	author	and	selecting	Manage	authors,	then	pushing	the	Recalculate	all	author	sort	values	button.	That	is,	the	device	should	show	up	in	Windows	Explorer	(in	Windows)	or	Finder	(in	macOS).	If	you	have	one	of	these,	uninstall	them	and	you	will	be	fine.	calibre	can	directly	connect	to	all	the
major	(and	most	of	the	minor)	e-book	reading	devices,	smartphones,	tablets,	etc.	On	some	64	bit	versions	of	Windows	there	are	security	software/settings	that	prevent	64-bit	calibre	from	working	properly.	calibre	tries	hard	to	ensure	that	EPUBs	it	produces	actually	work	as	intended	on	a	wide	variety	of	devices,	a	goal	that	is	incompatible	with
producing	valid	EPUBs,	and	one	that	is	far	more	important	to	the	vast	majority	of	its	users.	The	first	thing	to	understand	is	that	books	and	authors	are	separate	entities	in	calibre.	You	will	now	have	a	list	of	libraries	you	can	import.	This	will	automatically	change	the	name	of	the	author	in	all	the	books	of	that	author.	Getting	around	within	the	user
interface.	Note	that	uninstalling	does	not	touch	your	books	or	settings.	If	you	are	looking	for	a	first-grade	step	by	step	roadmap	to	show	you	the	way	to	the	maximum	benefits	of	your	Kindle	Fire	HD	device,	you	are	in	the	right	place.	Even	with	these	tools	there	is	danger	of	data	corruption/loss,	so	only	do	this	if	you	are	willing	to	live	with	that	risk.
Using	this	dialog	you	can	change	the	name	of	an	author	and	also	how	that	name	is	sorted.	Now	on	the	new	computer,	start	calibre	for	the	first	time.	calibre	even	has	a	nice	graphical	interface,	so	you	don’t	need	to	learn	its	search	language	instead	you	can	just	click	on	tags	to	include	or	exclude	them	from	the	search.	Such	a	file	looks	like:	Table	of
Contents	First	File
Second	File
.	To	those	of	you	that	claim	that	you	need	access	to	the	filesystem,	so	that	you	can	have	access	to	your	books	over	the	network,	calibre	has	an	excellent	Content	server	that	gives	you	access	to	your	calibre	library	over	the	net.	Instruction	Default	alarm	sound	This	setting	sets	the	default	sound	that	you	hear	when	you	set	an	alarm.	Note	that	if	there	is
currently	a	device	connected,	this	menu	option	will	not	be	available	–	so,	disconnect	any	connected	devices.	So,	when	using	these	services	to	send	mail	calibre	automatically	restricts	itself	to	sending	one	book	every	five	minutes.	An	easy	way	to	browse	your	calibre	collection	from	your	Apple	device	is	by	using	The	calibre	Content	server,	which	makes
your	collection	available	over	the	net.	You	can	tell	what	version	of	calibre	you	are	currently	running	by	looking	at	the	bottom	line	of	the	main	calibre	window.	If	you	are	worried	that	someday	calibre	will	cease	to	be	developed,	leaving	all	your	books	marooned	in	its	folder	structure,	explore	the	powerful	Save	to	disk	feature	in	calibre	that	lets	you
export	all	your	files	into	a	folder	structure	of	arbitrary	complexity	based	on	their	metadata.	In	particular,	be	aware	that	Google	Drive	is	incompatible	with	calibre,	if	you	put	your	calibre	library	in	Google	Drive,	you	will	suffer	data	loss.	Use	some	other	email	provider	instead.	You	can	export	all	calibre	data	(books,	settings	and	plugins)	and	then	import
it	on	another	computer.	A	common	encoding	for	many	files	from	the	web	is	cp1252	and	I	would	suggest	you	try	that	first.	By	default,	this	sort	algorithm	assumes	that	the	author	name	is	in	First	name	Last	name	format	and	generates	a	Last	name,	First	name	sort	value.	For	more	tutorials	and	videos	select	a	category	in	the	filter.	Authors	in	the	Tag
browser	are	sorted	by	the	sort	value	for	the	authors.	That	is,	another	HTML	file	that	contains	links	to	all	the	other	files	in	the	desired	order.	You	are	free	to	use	the	results	of	conversions	from	calibre	however	you	want.	When	backing	up	your	library	make	sure	you	copy	the	entire	folder	and	all	its	sub-folders.	An	easy	way	to	check	for	corrupted	fonts
in	macOS	is	to	start	the	“Font	Book”	application,	select	all	fonts	and	then	in	the	File	menu,	choose	“Validate	fonts”.	The	format	of	the	variable	is:	:password@servername	you	should	ask	your	network	administrator	to	give	you	the	correct	value	for	this	variable.	You	can	find	this	config	folder	via	Preferences → Miscellaneous.	There	is	however,	a	calibre
plugin	that	allows	you	to	create	collections	on	your	Kindle	from	the	calibre	metadata.	Point	it	to	the	previously	copied	folder.	One	common	source	of	problems	is	that	some	poorly	designed	antivirus	programs	block	calibre	from	opening	a	connection	to	send	email.	You	can	actually	browse	the	source	code	yourself	(or	hire	someone	to	do	it	for	you)	to
verify	that	it	is	not	a	virus.	calibre	is	licensed	under	the	GNU	General	Public	License	v3	(an	open	source	license).	Follow	these	steps	to	find	the	problem:	Make	sure	that	you	are	connecting	only	a	single	device	to	your	computer	at	a	time.	When	you	first	run	calibre,	it	will	ask	you	for	a	folder	in	which	to	store	your	books.	Make	sure	you	are	running	the
latest	version	of	calibre	(currently	5.43.0).	Your	only	recourse	is	to	either	reset	the	Kindle,	or	delete	all	files	from	its	memory	using	Windows	Explorer	(or	whatever	file	manager	you	use)	and	then	send	the	books	to	it	again,	one	by	one,	until	you	discover	the	problem	book.	Note	By	default,	when	adding	HTML	files,	calibre	follows	links	in	the	files	in
depth	first	order.	DJVU	support	is	only	for	converting	DJVU	files	that	contain	embedded	text.	Then,	just	add	this	HTML	file	to	the	GUI	and	use	the	Convert	button	to	create	your	e-book.	If	you	are	reconverting	a	previously	converted	book,	you	will	also	have	to	enable	the	option	in	the	conversion	dialog	for	that	individual	book	(as	per	book	conversion
settings	are	saved	and	take	precedence).	If	this	is	your	case,	then	do	the	following:	Set	the	author_sort_copy_method	tweak	to	copy	as	described	above.	calibre	does	not	guarantee	that	an	EPUB	produced	by	it	is	valid.
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